
Relight Neon



Relight Neon © Ben Willmore, All rights reserved 2

Relight Neon 

In this lesson, we’re going to learn how to re-light neon in a photograph. We’ll 
work on a particular image that has a lot of neon, but one part is burnt out. We 
will relight that area using a series of techniques. Note that this lesson will be use-
ful to you, even if you never plan on re-lighting neon, because the various take-
aways will be helpful in completing all sorts of Photoshop tasks. In the process of 
re-lighting the neon, you will learn about using the Pen Tool, using layer masks, 
applying layer styles and more. 

Reproduce Pipes Using Pen Tool (Timestamp 2:40)

The example image contains a lot of neon tubing. Much of the tubing is lit, but 
there is one building spire where the tubing is not lit. This is the area we’re going 
to light.

The first step will be to reproduce the actual neon tubing using the Pen Tool. The 
Pen Tool is used to create paths. After creating one or more paths, they can be 
seen within the Paths Panel, which is usually grouped with the Layers Panel. If 
the Paths Panel is not visible on your screen, you can access it by clicking on the 
Window menu and choosing Paths. 

At left, you can see 
before-and-after 
images of what we 
will accomplish in 
this lesson. A variety 
of techniques will be 
used to re-light the 
neon on the building 
spire.
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If you are working with the example 
image that is included with this les-
son, know that there is a path already 
created for the neon tubing. If you 
don’t want to manually create the 
path using the following steps, you 
can choose to use this pre-created 
path. In the lesson video, we will be 
making it from scratch. 

Before activating the Pen Tool, you’ll need to specify a setting that is found within 
the Path Selection Tool options. Activate the Path Selection Tool. (It looks like a 
black arrow icon, within the Toolbar on the left side of the interface.) Then, turn 
on the “Constrain Path Dragging” 
check box, which can be found in the 
Options Bar above the main image 
window. This setting will determine 
what happens when you click and 
pull on a path handle. By turning the 
check box on, it is causing the Pen 
Tool to behave the way it did in earli-
er versions of Photoshop. I, personal-
ly, find this to be helpful. 

Now, activate the Pen Tool, which can also be found in the Toolbar on the left side 
of the Photoshop interface. Zoom in on the image so that you can easily see the 
neon piping that you’re going to be lighting. Use the Pen Tool to create an accu-
rate shape of the neon tubing. 

NOTE: There is a separate lesson on using the Pen Tool. If you are not familiar with 
the tool, you can find the link to that lesson on the lesson page for THIS lesson. 
Additionally, the directions on using the Pen Tool will be included at the end of 
this handbook.

The lesson file includes this path, which has 
been created for you. You can find it within the 
Paths Panel.

LEFT: The Object Selection Tool is 
highlighted in green and the Pen Tool 
is highlighted in red. ABOVE: This 
setting can be found in the Options 
Bar when the Object Selection Tool is 
active. 
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After the path has been made, it will look like a blue shape in the image window 
and it will show up as the “Work Path” within the Paths Panel. You can dou-
ble-click on that name in order to give it a custom name, if you wish. Click away 
from the path (in the Paths Panel) if you’d like to hide it from view. Click back on 
the name if you’d like it to become visible again. 

Reproduce Neon Tubes (22:40)

Now you will use the path that you just made to create the neon tubes. This will 
need to be done on an empty layer, so make sure that the Layers Panel is open. 
Create a new layer by holding down the Option key (Alt on Win) and clicking 
the New Layer icon ( [+] ) at the bottom of the panel. By holding down the Op-

The Pen Tool is used to mimic the shape of the unlit 
neon tubing. After the path has been created, it will 
appear as the “Work Path” in the Paths Panel. 
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tion key, it tells Photoshop to open 
the New Layer dialog. Here, you can 
give the new layer a name (Neon) 
and then click OK. The new layer will 
appear above the image layer in the 
Layers Panel. 

Brush settings In order to create the 
neon, you’ll need to specify some 
settings within the Brush Tool. Ac-
tivate the Brush Tool and use the 
Options Bar brush setting to make 
the hardness pretty high. In the vid-
eo example, the hardness was set 
at 92%. Then, you’ll want the size of 
the brush to match the width of the 
piping, so zoom in on an area of pip-
ing and size the brush to match the 
width. The brush can easily be sized 
by using the left and right bracket 
keys ( [ ] ) on your keyboard. 

If you open the Info Panel and hover the cursor over the central, brightest part of 
the neon that is already lit in the image, you will see that the RGB readouts are all 
255. This means that there is no color in this central area. It’s pure white. In order 
for the neon you’re creating to match, its central area will also need to be white. 
Click on the foreground color swatch at the bottom of the Toolbar and make sure 
that the foreground color is set to white. 

The new layer is being named “Neon.”

The brush tip is being sized so that it’s the same 
width as the neon piping.

As we hover the cursor over the existing lit neon, we can see that the Info Panel shows 
255 as the values for red, green and blue. This means that the lit pipe is pure white. 
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Stroke Path Next, open the Paths Panel and click on the path that you created. (If 
you’re using the image included with this lesson, you could also click on the path 
that was pre-created for you.) This will make it active and you will see the blue 
outline appear in the image window. 

Make sure that the Brush Tool is still active and click on the second icon (the 
Stroke Path icon) at the bottom of the Paths Panel. This will take the tool that is 
currently active (the Brush Tool) and use it to trace the active path. After outlin-
ing the path, you can click away from the name of the path in the Paths Panel in 
order to hide the path outline. You should now see the neon tubes as pure white 
and they should be contained within the new layer that you created. 

A stroke was added to the path, using the current Brush Tool settings (a small, hard, white 
brush). You can see the white tubes appear (under the blue path line).
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Add the Glow Effect (26:00)

The tubes have now been created so it’s 
time to make them glow. If you look close-
ly at the neon that is already lit, you can 
see that it’s actually putting out two col-
ors. The color closest to the tubing is a lit-
tle more cyan/blue and as you move away 
from the tubing, it becomes more of a 
vivid green. We’ll use both these colors in 
re-creating the neon. Layer styles will be 
used to create the effect.

Outer Glow layer style With the new neon layer active, click on the FX icon at 
the bottom of the Layers Panel and choose Outer Glow from the pop-up menu. 
This will cause the Layer Styles dialog to open, with the Outer Glow settings at 
the forefront. The color swatch will determine the color of the glow. Click on it 
and the Color Picker will appear. When the Color Picker is active, the cursor will 
automatically switch to the eyedropper when you hover over the image. Use the 
eyedropper to click on the blue/cyan color that’s closest to the tubing that’s al-
ready lit. Click OK to close the Color Picker and return to the Layer Style dialog. 

The glow is blue in the areas closest to 
the existing lit neon and green in the  
areas farther from the neon tubing.

In the Layer Style  
dialog, we clicked the 
color swatch to call up the 
Color Picker. Here, we are 
using the eyedropper to 
click on part of the blue/
cyan color that is close to 
the existing lit neon.
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You’ll use the settings here to determine what the glow will look like, and it will 
help if you position the image window so that you can see both the lit neon and 
the neon you created and are applying the effect to. 

Use the following settings to mimic the look of the blue-ish portion of the existing 
neon:

• The Size slider: This will determine how much blurring will be applied to the 
glow. If you drag this slider up, you will see the glow start to get wider and 
wider. 

• The Spread slider: This determines how much of the glow will be solid (as op-
posed to translucent). 

• The Opacity slider: This slider controls the opacity of the entirety of the effect. 

Click OK once you’re happy with the effect. This will close the Layer Style dialog. 

The Size, Spread and Opacity sliders are being used to create a glow effect that matches the 
glow of the neon that is already lit.
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Next, you’ll create the green part of the glow. You will need to do this on a second 
neon layer because the Outer Glow effect is something that can only be applied 
once to a layer. Unlike some other layer styles, you can not have more than one 
instance of the Outer Glow on one layer. 

Duplicate the neon layer that you already have by using the keyboard shortcut 
Command+J (Ctrl+J on Win). Alternatively, you can duplicate a layer by dragging 
it to the New Layer icon at the bottom of the Layers Panel. Drag this duplicate 
layer beneath the original neon layer and rename it to something you’ll recognize. 
In the lesson video, we name the layer “Big Glow.” 

There is already one layer containing the actual neon tubing, so we don’t want 
the tube to appear in this layer. We want the neon tube to define where the glow 
shows up, but we don’t want it to actually be visible in this duplicate layer. We 
only want the second, larger glow to show up here. You can accomplish this by 
using the Fill setting. Both the Opacity and Fill settings can be found at the top 
of the Layers Panel. The Opacity setting controls the opacity of both the contents 
of the layer and any layer styles applied. The Fill setting, on the other hand, ONLY 
controls the opacity of the layer contents. The layer styles (the glow, in this case) 
will retain their full opacity. With the duplicate, big glow, layer active, set the Fill 
setting to 0%. This will cause the tube to disappear, but the glow will remain. 

This illustration demonstrates the 
difference between the Opacity 
and Fill settings. The arrow on the 
left shows the original layer, which 
has an Outer Glow layer style  
applied. The center graphic shows 
the same layer with the Opacity 
setting very low. The graphic on 
the right shows the same layer 
with the Fill setting at 0%. You can 
see that the Opacity setting affects 
everything and the Fill setting  
affects the contents of the layer 
but not the layer style.  
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Now you’ll adjust the glow on this layer, changing it from the smaller blue glow 
to the larger green glow. Again, make sure that you can see both the layer you’re 
working on and the reference neon in the image window. Double-click on words 
“Outer Glow” beneath the layer name. The Layer Style dialog will appear, with the 
Outer Glow settings at the forefront. Click on the color swatch to call up the Color 
Picker. Again, use the eyedropper to click within the image on the color you want. 
In this case, you’ll click on the green part of the glow from the existing lit neon. 
Click OK to close the Color Picker. 

Now, you can adjust the Size and Spread settings to make that green glow larger. 
In the video example, we increased the Size setting to 81px and decreased the 
Spread setting to 13%. Once you’re satisfied, click OK to close the Layer Style di-
alog. 

In the Outer Glow settings of the Layer Style dialog, the Color Picker is being used to sample 
the green color from the lit neon in the image.
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Add Light Shining on Tower (33:50)

The neon tubes are looking good, so we’ll 
turn to the building next. If you look at the 
part of the building (the spire, in particular) 
that already had the lit neon, you can see 
that the neon caused the building to become 
very saturated in the same color. You’ll need 
to create that look on the part of the build-
ing that is holding the neon you just created. 

In the Outer Glow settings of the Layer Style dialog, the Size and Spread sliders are being 
adjusted to make the green glow radiate more. 

We need to make the spire on the right 
match the color of the spire on the left.
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Start by hiding the two neon layers. You can toggle a layer’s visibility by clicking 
the eyeball icon to the left of the layer thumbnail. Click on the original image layer 
to make it active and then create a Curves Adjustment Layer by clicking the Ad-
justment Layer icon at the bottom of the Layers Panel (It looks like a circle that’s 
half black, half white) and choosing Curves from the pop-up menu. The new ad-
justment layer will be added and the Curves settings will appear within the Prop-
erties Panel. Make sure that the Targeted Adjustment Tool is active. It looks like a 
little hand icon, on the left side of the panel. 

When the Targeted Adjustment Tool is active, the cursor will look like an eyedrop-
per. Hover the eyedropper over the part of the image you want to affect. In this 
case, it’s the spire of the building that needs the added color. Instead of simply 
clicking on the area, you’ll use a special trick. Hold down the Shift+Command 
keys (Shift+Ctrl on Win) and THEN click on the area. By doing this, Photoshop 
will measure the exact amount of red, green and blue found in that spot and it will 
place points on all three color curves, representing those amounts. You won’t ini-
tially see anything happen. You will need to use the color menu above the curve 
chart to switch between the three color curves. You will see the points have ap-
peared on those curves. 

With the Targeted Selection Tool active (cir-
cled), we are holding the Shift+Command 
keys while clicking on the area we want to 
affect. This places a point on each of the 
three color curves. 
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Don’t touch these curves, as you want those points to stay in place and active. If 
you accidentally click somewhere and deactivate the curve point, know that you 
can cycle through the points on the curve by using the plus and minus keys. Make 
sure that the new point is active. An active point will be solid and a point that’s 
not active will be hollow. 

Use the menu to view the red curve and note the Input and Output numbers be-
neath the curve chart. These will tell you how much red is in the image. You need 
to figure out how much red there SHOULD be in order to make the area look like 
the area you are referencing. In this case, the reference area is the spire that has 
the green light on it. Hover the cursor (with the Targeted Adjustment Tool active) 
over the reference area (without clicking) and make a note of the number that 
appears in the Input/Output fields. In the video example, that number is 127. This 
tells you how much red light is in the area where the mouse is. Then, move your 
cursor to the Properties Panel and click within the Output field. Change this field 
to the number you noted. 

ABOVE: With the Targeted Adjustment Tool 
active, we are hovering the cursor over the area 
we are trying to match. RIGHT: When we hover 
over that area, we are noting the number in the 
Input/Output fields.
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Next, switch to the Green curve and do the same thing. Hover the cursor over the 
reference area and make a note of the Input/Output number. In the video exam-
ple, it’s 204. Enter that number into the Output field. Do the same thing with the 
Blue curve. In the video example, the reference area had a number of 148 so that’s 
what we typed into the Output field. 

Now, the color of the targeted area should match the color of the reference area. 
However, the rest of the image changed as well. That’s ok, because you can use 
a layer mask to selectively apply the effect in the area where it should be visible.

The Output fields have been changed for each of the three color curves. The spire is now the 
correct color, but the rest of the image has changed as well. A layer mask can be used to  
correct this. 
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The Curves Adjustment Layer 
will already have a layer mask at-
tached to it. Make sure that the 
mask is active (it should have little 
white brackets around its thumb-
nail). By default, the layer mask 
will be white, which means that 
the adjustment is affecting the 
entire image. (With layer masks, 
white reveals and black conceals.) It will be easier to start with a black mask, so 
click on the Image menu and choose Adjustments > Invert. This will invert the 
mask to make it completely black. Now, the effect is completely hidden. 

You can selectively reveal the effect by painting on the layer mask. Activate the 
Brush Tool and make sure you’re using a large, soft-edged brush. Make sure that 
the foreground color is set to white and then paint over the area where the col-
ored effect should be. In the image example, we painted over the spire of the 
building so that it matched the spire that was already lit. You may want to turn on 
the visibility of the two neon layers as you do this. 

When an adjustment layer is created, it will auto-
matically have a white mask applied to it. Here, you 
can tell that the mask is active because it has little 
white brackets around it.

We hid the colored layer 
completely by making 
the mask completely 
black. Here, we’re  
painting with white on 
the mask in order to 
reveal the effect only in 
the area where the neon 
light should be hitting 
the building. 
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Fix Neon in Areas Where it’s Behind Building (43:15)

The next step will be to clean up the neon. There are areas where it should look 
as if it is hidden behind parts of the building, so you’ll need to hide it in those 
areas. A layer mask can be used to accomplish this. Hide all of the layers except 
the original image layer and the layer you created containing the neon tubing 
(this is the layer where the tubing is visible, with the Fill setting at 100%). Click on 
the neon layer to make it active and then add a layer mask by clicking the Layer 
Mask icon at the bottom of the Layers Panel (It looks like a rectangle with a circle 
inside). 

You will need to paint on the mask and it can be useful to create an accurate se-
lection of the building. This will help to limit your paint strokes so that you don’t 
get overspray. You can do this by using any selection method that you’re com-
fortable with. Likely, you will use a combination of features, like the Select Subject 
command and the Quick Selection Tool. 

Note: If you’re using the image file provided with the lesson, you can cheat by 
loading a selection that has been saved within the file. To do this, click on the 
Select menu and choose Load Selection. In the Load Selection dialog, set the 
Channel menu to the “Building” option and then click OK. The “marching ants” 
selection of the building will appear in the image window. 

The selection will help you to paint 
on the layer mask without getting 
overspill into the area surrounding 
the building. Make sure that the 
mask is active and zoom in on the 
image so that you can easily see 
the areas where the neon wrongly 
overlaps the building. Activate the 
Brush Tool and use a small brush to 
paint with black over those areas. 
Adding black to a layer mask will 
hide parts of the layer. 

With the neon layer active, we’re painting with 
black on the layer mask in order to hide the neon 
in the areas where it should be obstructed by the 
building. 
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Further Refinements (45:40)

In the example image, there are little wire connectors holding the neon to the 
building. It could be nice to break through the neon a bit so that those connectors 
are partially visible. You can use the layer mask that’s attached to the neon layer 
to achieve this. When the neon layer is visible, it’s impossible to see the connec-
tors, so you’ll want to hide the layer when working on the mask. The problem is 
that Photoshop does not allow you to work on a mask that is attached to a hid-
den layer. To get around this, you can use a trick. 

There is a way to view the layer mask as an overlay on the picture and that is by 
tapping the Backslash key. In this view, any black parts of the mask will have a 
red overlay and any white parts of the mask will look normal. You can paint on 
the mask in this view, adding black to hide parts of the layer and adding white to 
reveal parts of the layer. Use a small brush to paint with black over the wires con-
necting the neon to the building. If you’d like to only partially hide the neon, you 
could paint with a shade of gray instead of black OR you could paint with black 
but lower the opacity of the Brush Tool. When you’re satisfied, tap the backslash 
key again to remove the overlay view. 

LEFT: If you zoom in on the neon piping, you can see wire connectors that attach the neon to 
the building. RIGHT: While viewing the mask in the image window, we are painting with black 
over the connectors. This is adding a red overlay, indicating that the area will be hidden by 
the mask.
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The layer containing the larger, blue 
glow should also have the same in-
terruptions, where the glow is hid-
den in the areas where the build-
ing obstructs the neon and in the 
areas where the wire connectors 
are. You can easily achieve this by 
copying the layer mask that’s at-
tached to the neon layer and ap-
plying it to the big glow layer. To 
copy a mask from one layer to an-
other, hold down the Option key 
(Alt on Win) and drag the mask to 
the layer you want it applied to. By 
holding down the Option key, you 
are copying the mask instead of 
simply moving it. 

Add Noise (52:30)

The final step in making the effect look natural is to add noise to the glowing 
areas. You can use a new layer to do this. The Camera Raw filter will be used to 
create the noise because I find that it provides the most realistic-looking result. 
The Camera Raw filter can not, however, be applied to an empty layer. To get 
around this, you can use a new layer that is filled with 50% gray. Then, you can 
use a blending mode to make the noise blend with the image. 

Click on the Adjustment Layer icon at the bottom of the Layers Panel and choose 
Solid Color from the pop-up menu. The Color Picker will appear and you can drag 
the little circular selector all the way to the left of the color square. Then, type 50 
into the B field, which stands for brightness. This will create 50% gray. Click OK to 
exit the Color Picker and the new layer will appear in the Layers Panel. Drag it to 
the top of the layer stack. 

The layer mask is being copied from one layer to 
another.
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With this new layer active, click on the Filter menu and choose Camera Raw. A 
warning will appear, because the Camera Raw filter is not designed to work on an 
adjustment layer. The warning dialog will ask if you’d like to convert the layer into 
a smart object. Choose YES and then the Camera Raw window will open. 

The adjustment settings will be found on the right side of the Camera Raw win-
dow. Expand the Effects panel and you’ll find the Grain settings. Drag the Grain 
slider to the right until you can see a bit of grain appearing in the gray. You may 
need to zoom in on the image so that you can see it better. Then, use the Size 
and Roughness sliders to fine-tune the look of the grain, if you like. Click OK to 
exit the Camera Raw filter. 

The gray layer will be filled with grain, but it will hide the image layer. To fix this, 
use the Blending Mode menu at the top of the Layers Panel to set the layer to one 
of the modes in the Overlay category. With this set of blending modes, anything 
that’s 50% gray will disappear, leaving only the noise. 

A Solid Color layer is being created and we are using the 
Color Picker to make sure that the layer is 50% gray. The 
Solid Color layer will appear in the Layers Panel (right).
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Now, the noise is affecting the entire image. The noise should only be applied in 
the area where the glow is and you can use a layer mask to achieve this. Hold 
down the Option key (Alt on Win) while clicking on the Layer Mask icon at the 
bottom of the Layers Panel. By holding down the Option key, it will create a mask 
that is filled with black. In a layer mask, black hides the layer, so all of the noise 
will become hidden. You can now activate the Brush Tool and use a soft brush to 
paint with white over the area where the noise should be visible. This will be in the 
areas where the glow has been added.

ABOVE: In the Camera Raw filter, the Grain settings are 
being used to add noise to the gray. RIGHT: The blend-
ing mode of the grain layer is being changed to Overlay.
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The Pen Tool in Photoshop

This section is going to cover the basics of the Pen Tool in Photoshop. The Pen 
Tool can be used to draw shapes, select objects or to mask a layer so that it only 
shows up inside a particular shape. The Pen Tool is good for defining areas that 
are made up of straight lines and smooth curves. It is not good for selecting 
things that have soft edges, fuzz or fluffy hair. 

The Pen Tool can be found in the Tool Bar 
on the left side of the interface. If you click 
and hold on the Pen Tool icon, you will see 
that there are different versions of the tool 
that you can choose from. When you use 
the Pen Tool, you are creating a path. Once 
you have a path in your document, you can 
do one of three things with it, and these op-
tions can be found in the Options Bar above 
the main image window.  

• Selection: This option will convert the path into a selection.

• Mask: Choosing this option will turn the path into a mask, attached to the ac-
tive layer.

• Shape: This will create a shape layer out of your custom path just as if you 
used the Shape Tool. 

The second tool hidden behind the Pen Tool icon is the Freeform Pen Tool. When 
activated, you can use this tool to click and drag out a shape in a similar way that 
you would use the Lasso Tool. As long as you let go of your mouse button in the 
same place that you started, you will end up with a closed path. While this may 
be the easiest of the Pen Tool options, I find I use this one the least. 

If you click and hold on the Pen Tool 
icon in the Tool Bar, you will have access 
to all the versions of the tool.

Once you have a path, 
you can use these op-
tions to tell the path 
what to do.
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The version of the tool that I use the most is the regular old Pen Tool, and this is 
the top option as well as the default option for the tool. 

Creating a shape made of straight lines The simplest kind of path to create is 
one that is made up of all straight lines. With the Pen Tool active, click in your 
document to add a point. Then click somewhere else to create a second point 

with a straight line connecting them. Keep 
clicking to add points, creating the shape 
you desire. In order to create a finished, 
closed path, you will need to click back in 
the same place that you started. When you 
hover your cursor over that place, your cur-
sor will get a little circle icon next to it, indi-
cating that you are about to close the path.

Creating a shape made of curved lines If you click and drag with the Pen Tool, 
you will create a point with handles attached to it. These handles determine what 
direction the line will travel in when it moves away from the point. When cre-
ating a path for a curved object, you want to think about the different curves 

that the object is made out of. The points 
should be placed in the areas where one 
curve transitions into another curve and 
you would click and drag, placing points 
with handles in each of these areas. The 
length of the handle will determine how 
strongly it influences the direction of the 
line. A short handle will force the line to 
follow that direction for a short distance. 

The circle icon appears next to the cur-
sor when you’re about to close the path.

Here is an example of when 
a straight-lined path is very 
useful. I wanted to mask 
everything except for the X 
in this layer. I used the Pen 
Tool to make a path around 
the X and then I chose 
Mask from the choices in 
the Options Bar. 

The length of the  
handles determine how 
strongly they influence 
the direction of the 
curve.
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A long handle will force the line to follow that direction for a longer distance be-
fore deviating toward the next point. 

It takes a little while to get used to know-
ing how long the handles should be. The 
following technique will help with that. The 
Direct Selection Tool can be found in the 
Tool Bar and it is designed to modify a path 
that you’ve already created. You can use it 
to click on the different points to make the handles re-appear so that you can 
modify them or you can use it to click and drag on the path itself. When dragging 
on the path itself, it will automatically change the length and angle of the han-
dles on either side of the path segment. I like that this changes the length of the 
handles, but I don’t want this to change the angles of the handles. I can specify 
this by turning on the “Constrain Path Dragging” check box in the Options Bar 
(when the Direct Selection Tool is active). If I do this, I can quickly create a path 

and then drag all of the curve segments to 
fine-tune how long the handles are, therefore 
perfecting the curve. If a curve is still slightly 
off, it means that you will have to adjust the 
direction of the handles.

You can access the Direct Selection tool while 
you’re in the Pen Tool by holding down the 
Command key (Ctrl on Win). The entire time 
you have the Command key held down, you 
will be using the Direct Selection Tool. When 
you let go, you will get the Pen Tool again. 

If you have a path that’s already completed, you may find that 
you need to add a point in order to change or fine-tune the 
path. With the Pen Tool active, hover your cursor over the path. 
You will see a little plus (+) symbol appear next to the cursor 
and this means that you can click on the path to add a new 
point. You can then hold down the Command key to access the 
Direct Selection Tool to adjust the handles of the new point.

The Direct Selection Tool can be found 
hidden behind the Path Selection Tool.

The Direct Selection Tool is used to 
drag the curve into the best position.

The plus symbol 
indicates that you 
can add a point 
to the curve.
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Creating a path with abrupt corners When you click and drag, you get handles 
that come out of both sides of the point, creating a smooth curve. If you need to 
create a sharp angle, activate the Convert Point Tool, which can be found behind 
the Pen Tool icon in the Tool Bar. With the Convert Point Tool active, you can click 
and drag on the handles to move them independently of each other and create a 
sharp, angled transition in the path. To change a point that has a sharp angle and 
make it smooth again, use the Convert Point Tool to click on the point and drag 
out new handles. 

Note that you don’t have to manually use the menu 
to access the Convert Point Tool. There is an easy 
way to access it while using the Pen Tool. With the 
Pen Tool active, hold down the Option key (Alt on 
Win) to temporarily access the Convert Point Tool. 
The entire time you have the Option key held down, 
you will be using the Covert Point Tool. When you 
release the key, it will switch back to the Pen Tool. 
This makes it very easy to create both curved lines 
and sharp edges while creating a shape with the 
Pen Tool. 

Sometimes, you will need your path to have a curve on one side of a point and 
a straight line on the other side of the point. With a point that has two handles 
creating a smooth curve, hold down the Option key (Alt on Win) to temporarily 
access the Convert Point Tool and click once on the point. This will remove the 
handle on the open end of the path. To create a handle on a point that doesn’t 
have one already, hold down the Option key while you click on the point and drag 
out a handle. 

Pen Tool Options In the Options Bar, there is a menu on 
the left side where you can decide whether you want to 
use the Pen Tool to create a Shape or a Path. I usually 
keep this set to Path. The options next to “Make:” will tell 
Photoshop what to do with your path. You can take a 
path and convert it into a selection, apply it as a mask or 
create a shape layer from it. 

The Convert Point Tool will 
allow you to move the handles 
independently of each other, 
creating a sharp angle instead 
of a smooth curve. 

With the Pen Tool active, 
you can decide whether 
you want to use it to cre-
ate a Shape or a Path. 
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The icon that looks like two overlapping 
squares will give you a menu where you 
can choose what happens if you draw 
an additional shape while the previous 
shape/path is still active. For example, 
if you choose the Subtract option, the 
current shape will create a hole in the 
previous shape in the areas where the 
two overlap. 

The Paths Panel After you have created a path, it will appear inside the Paths pan-
el, which is usually hidden behind the Layers panel. If the Paths panel is not visible 
on your screen, you can access it by going to the Window menu and choosing 
Paths. By default, the active path will be called the Work Path, and this indicates 
that it’s a temporary path. If you would like to make the path more permanent, so 

that you can hide it and then access it again later, 
double click on the text “Work Path” and give it a 
new name. This will save the path for future use 
and it will allow you to have a new Work Path. To 
work on a path that you previously saved, simply 
click on it in the Paths panel and it will become 
visible in your document.

Creating a mask from a path As we covered ear-
lier, you can convert an active path into a layer 
mask by clicking the Mask button in the Options 
Bar at the top of the interface. When you do this, 
the layer mask will appear as a thumbnail next to 
the layer thumbnail in the Layers Panel. There will 
be brackets surrounding both thumbnails, indicat-
ing that both the layer and the path are active. You 
will still see the path in your document. To hide the 
path, simply click on the layer mask thumbnail to 
remove the brackets. Click on it again to make the 
path visible (and editable) again.  

This menu will determine how two paths will 
interact with each other.

The Paths panel can usually be 
found hidden behind the Layers 
panel. 

The path is active in the top 
screen shot and inactive in the 
bottom one.
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Create multiple segments in a single path One path can have multiple, discon-
nected segments. If you’d like to end one segment and start another, hold down 
the Command key and click away from the path line. This will deactivate the last 
point so that you can click again to create a new segment. 

Visual Recap

A: Point

B: Path Segment

C: Handle

A path made up 
of points with no 
handles

A path made up of 
points with handles 
creating one smooth,  
continuous line. 

A path made up of 
points with handles 
that create curves 
but point in different 
directions, creating 
abrupt transitions.

A path that combines 
different types of  
handles that create 
different types of  
transitions.


